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Introduction 
 
 Imagine the frustration and exasperation of having to read and 
understand a court filing formatted with mixed font types and sizes? 
 

Or trying to hand write notes or add electronic notes on a brief with the text aligned all the 
way to the page’s edge? 

 

How about squinting to read a copy created using carbon sheets? 
 

 Who would not love to work through a 40-page brief of 
unnumbered pages and one with 120 pages of exhibits (also unmarked 
and of mixed page orientation) tacked on? 
 

 Imagine you are litigating a case in a court that still uses paper 
filings and opposing counsel prints and serves everything on 90# paper. 
 

 In the paper filing world, each of those hypotheticals is not the 
norm. None make sense. Many probably logically assume that’s why we 
normally do not encounter them. 
 

 People do not use 90# paper, by default, because it’s more 
expensive, bulky, and simply unnecessary. Who would do that? 

 

 Parties number their pages and, usually, mark their exhibits. 
(Here’s a secret: Jurists silently award extra credit points when an 
index table prefaces extensive exhibits, especially in the trial 
courts.1) 

 

 Copy machines rendered carbon sheets irrelevant long ago, in 
most law offices.2 

 

 The default settings for most word-processing programs ensure 
adequate margins. 

 

 And of course, court rules typically dictate paper and font sizes. 
 

 But the electronic-filing environment has changed the field. Efiling’s 
many benefits are undisputed. Yet the quality of electronic filings is less 
predictable because many filers do not know how to assemble an optimal 
filing. This is not a critique about writing style or citation content.3 (That is 
better left to law school legal research and writing professors, writing 
gurus like Ross Guberman, or Jack Metzler’s “Cleaning Up Quotations” 
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(https://ssrn.com/abstract=2935374)). This guide is, instead, intended to 
be a helpful resource that focuses on the electronic-file packaging. 
 

Some electronic filings are beautifully assembled, and that effort is 
appreciated. Other filings are not so great. The not great ones are 
unfortunate because a poor electronic filing undermines the document’s 
purpose: to inform helpfully and persuade. 

 

“All aspects of a brief—its basic ideas, its tone, its sentence 
structure, its word choice, its punctuation, its page layout—matter. Let 
other lawyers think these things unimportant. They’ll suffer, and you’ll best 
them.”4 Bryan Garner’s warning should also apply to how the electronic file 
is prepared. It matters. 

 
In the typography realm, Matthew Butterick warns, “bad typography 

can distract your reader and undermine your message.” To hold the court’s 
attention “you can’t undermine your argument with distractions. It’s the 
same on the printed page.”5 This guide suggests that the same holds true 
with electronic-document formatting. 
 

It should be a filer’s goal to create efilings of optimal utility, in the 
electronic and print environments. In the electronic environment, this 
means that the file size is no larger than necessary (without compromising 
visual quality); the font is crisp and readable; the file is appropriately 
bookmarked, linked, and searchable; all attached photos and small-print 
contracts are clear; there are no blank pages; and all pages are properly 
oriented. In the print environment, it means that your electronic 
submission prints well and is just as usable as if it had been paper-filed. 
 

 The accompanying suggestions will likely require you to develop a 
larger frame of reference. Of course one wants to be thinking about the 
particular assigned judge. But it’s in your (and your client’s!) better interest 
to be likewise sensitive to the real possibility that other judges and 
individuals (staff attorneys, interns, law clerks, clients, risk managers, the 
public, or media) will also read and share these efilings. Your efiling should 
be packaged so that it is presented professionally and functional for all.  

https://ssrn.com/abstract=2935374
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Qualifiers and limitations (the fine print) 
 

 It’s critical that you be familiar with your court’s efiling rules, 
administrative orders, and standards. Courts vary in their technical 
requirements (margins, external hyperlinks, file-size limits, requiring or 
forbidding PDF/A formatting, and so on). No third-party guide can 
substitute your devoting the necessary effort to be familiar and current 
with those requirements. 
 

 This resource focuses on static documents (such as pleadings, 
briefs, and exhibits, memoranda, correspondence, and reports). It does not 
address preparing dynamic documents intended to be later modified by a 
court (such as proposed orders for future entry). 
 

 Similarly, this resource is not a step-by-step tutorial on how to 
create an appellate title page, table of contents, index of authorities, 
jurisdiction statement, and so on. 
 

 This resource references the Microsoft Word, Adobe Acrobat, and 
Bit.ly trademarked products. Screenshots were captured using Microsoft 
Office Professional Plus 2016 (for Windows) and Adobe Acrobat DC. Some 
screenshots also display the BriefCatch legal editing plug-in tool for Word. 
This resource is not endorsed by these products. 
 

There are plenty of other word-processing, .pdf-creating, and web 
link-shortening programs. While they do not always share similar features 
as Microsoft Word, Adobe Acrobat, or Bit.ly, you should be able to discern 
which products will enable you to perform the outlined functions. 

 

Comments are suggestions can be emailed to the author, Lori 
Shemka, at lori@lorishemka.com. Follow her on Twitter at @shemkalegal 
 
 

  
  

https://briefcatch.com/
https://twitter.com/shemkalegal
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I. Word processed document formatting 
 

A. Layout page size (8-1/2 x 11-inch) 
 

Why should page size matter if a document is efiled? It’s not like 
clerks of the court still have to worry about paper documents fitting into 
pre-purchased file folders or metal-filing cabinets of set dimensions. 

 

Page size will always matter because, inevitably, someone is going 
to hard print what was electronically filed. Your assigned judge, client, or 
opposing counsel may prefer to review things on paper, or a member of 
the public may purchase a printed copy from the clerk’s counter. 

 

An electronic file that includes pages not sized for 8-1/2 x 11-inch 
paper probably will not print if the printer only handles 8-1/2 x 11-inch 
paper. The judge, her staff, or the clerk of the court may not immediately 
understand why their printer keeps displaying an error message if your file 
includes non-conforming page sizes. But be assured that the frustration 
over your non-printing file will escalate. You do not want to cause that ire.  

 

It is best to make sure that all of your documents and attachments 
are electronically formatted only to print on 8-1/2 x 11-inch sheets. 
 

You can verify your “Page Setup” settings in Microsoft Word by 
selecting the “Layout” tab in the Word ribbon, and then selecting the pop-
out arrow in the lower right “Page Setup” corner. 

 

 
  
From that point, you can verify (and adjust, if necessary) the settings under 
the “Paper” tab. 
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[Word side trip: What if you cannot view the command ribbon as you look 
at Word? What if your view of Word looks like this with no ribbon at the 
top? 
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To adjust this, select the icon near the upper right corner that will then 
reveal your “Ribbon Display Options.” 
 

 
 

Hover over that icon and, at its drop-down, select “Show Tabs and 
Commands.” Now the Tabs and Command ribbon will display at the top of 
your Word document.] 
 

 
 
 

B. Fonts: type, size, and embedded 
 

Consult the court rules, administrative orders, and any local-efiling 
guides for font type and size restrictions or minimal requirements. Failure 
to follow those requirements may lead to your efiling being rejected. With 
those preliminaries understood … 

 
1. Type 

 

If the rules and guides are silent, consider using standard fonts such 
as Arial, Calibri, Cambria, Constantia, Georgia, Tahoma, or Times New 
Roman. This resource uses Segoe UI. A word of caution: While Times New 
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Roman is the default font of choice for many court filers, more folks are 
moving away from it.6 
 

2. Size 
 

In my home, Michigan, font size must be, at least, 12-point 
(including for footnotes). And do not be shy about going big with 13- or 
14-point.7 Since long-term reading can be eye straining, many judges 
appreciate the larger font. 

 

(As a courtesy, at least at the trial court level, it may not hurt to 
phone the judge’s assistant or law clerk and simply ask if the judge has a 
font-size preference.) 
 

3. Embed your fonts 
 

It is also a best practice to embed your 
selected font into your Word document to 
ensure that others who access your file using a 
different word-processing program or .pdf 
viewer will view your document as you created it.  

 

What can go wrong if you do not embed 
your fonts? If the person reading your document 
does not have your font loaded into their 
particular word-processing program or .pdf 
viewer, their program will substitute your font for 
one of theirs. Translated: a visual mess. 
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To embed your fonts, in the Word document you are working on, 
go to the “File” menu and select “Options.” 
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Select “Save” in the left pane. And below the heading “Preserve fidelity 
when sharing this document,” check the “Embed fonts in the file” box. And 
check the separate box to “Embed only the characters used in the 
document (best for reducing file size).” 
 

 
Select “OK” to save the settings for this file. 
 

Tip: Fonts are automatically embedded if they are saved in the PDF/A 
format, so the above step is unnecessary if you are in that camp. 
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C. Margins and line spacing 
 

Check your jurisdiction’s margin and spacing requirements. Failure 
to follow those requirements may lead to your efiling being rejected. 

 

Know where the court’s electronic filing watermark will land before 
you draft your original pleading or brief. The goal (and this should be 
inclusive of your exhibits) is to avoid margin settings where the court’s 
efiling watermark will overlap your text or images. 
 

It also helps to add space between lines when creating bulleted or 
numbered lists. 

 
Do not stack your items like this.  

This is difficult to read. Add space between each item, instead. 

 
Board members serve staggered three-year 

terms.  Supreme Court appointments to the 

Board of Review, effective January 1, 2018, are: 

• Donna F. Bos, Fully Certified 
Interpreter (term expires December 
31, 2019) 

• The Honorable Thomas K. Byerley, 
Eaton County Probate Court (term 
expires December 31, 2018) 

• The Honorable William G. Kelly, 
Kentwood District Court (term expires 
December 31, 2019) 

• The Honorable Suzanne Hoseth-
Kreeger, Ionia/Montcalm County 
Circuit Court(term expires December 
31, 2020) 

• Susan E. Reed, LEP Population 
Advocate (term expires December 31, 
2018) 

• Mary F. Rubio, Prosecuting 
Attorney (term expires December 31, 
2020) 
 

 
Board members serve staggered three-year 

terms.  Supreme Court appointments to the 

Board of Review, effective January 1, 2018, are: 

• Donna F. Bos, Fully Certified 
Interpreter (term expires December 
31, 2019) 

• The Honorable Thomas K. Byerley, 
Eaton County Probate Court (term 
expires December 31, 2018) 

• The Honorable William G. Kelly, 
Kentwood District Court (term expires 
December 31, 2019) 

• The Honorable Suzanne Hoseth-
Kreeger, Ionia/Montcalm County 
Circuit Court(term expires December 
31, 2020) 

• Susan E. Reed, LEP Population 
Advocate (term expires December 31, 
2018) 

• Mary F. Rubio, Prosecuting 
Attorney (term expires December 31, 
2020) 
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One way to add the space is to highlight the relevant text, go into the 
“Paragraph” settings, and adjust the spacing for space to be included 
“After” each paragraph item. 
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D. Accurately caption or title your primary document 
 

Your primary document’s title should accurately, and with 
specificity, identify the file. For example, if there are three co-defendants 
but only one files a “Motion for Summary Disposition,” that document 
should not be titled “Defendant’s Motion for Summary Disposition.” Be 
more specific: “Defendant [Name]’s Motion for Summary Disposition.” 
 

E. Bookmarks 
 

The bookmarking topic occurs in two contexts: bookmarking the 
brief’s sections, and bookmarking the individual exhibit components. 
 

1. Bookmarked brief 
 

Here, different sections are bookmarked so the reader can easily 
jump to different areas within the document. These bookmark types are 
helpful when thoughtfully crafted. 
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Bookmarks can (and should) be created in Word, using the 
“Heading” Styles, while the primary document is authored. To do this, first 
verify (and likely adjust) the font, paragraph, and numbering settings for 
“Heading 1,” “Heading 2,” “Heading 3,” “Heading 4,” and “Heading 5.” 

 

Notice how the default settings are of larger font size and in light blue: 
 
 

 
 
 

To adjust these style settings, either select the expand arrow in the 
lower right corner of the “Styles” menu or select Alt + Ctrl + Shift + S. The 
“Styles” menu will appear. 
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Next, select each “Heading,” select the drop-down menu, and choose  
“Modify...” 

 
 
 
 

Now you can modify each heading to the proper font type, size, 
formatting, and color for your document. The most efficient way to 
approach this is navigating through the “Format” drop-down menu in the 
lower-left corner and toggling the settings for “Font…,” “Paragraph…,” and 
“Numbering…” 
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Tip: If you want to avoid repeating having to make these settings 
adjustments in future documents, mark the button for the changes to 
occur also in “New documents based on this template.” 
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Format settings to consider when modifying Heading styles:8 
 

 
 Font 

size 
Font 
style 

Paragraph 
line 

spacing 

Paragraph 
indent 

Numbering 
format 

 

Heading 1 
(Subject 
Headings) 
 

12 Bold Single, 
6 pt before 

None. 
Center 

alignment. 
None 

Heading 2 
(Argument, 
first-tier) 

14 Bold9 Single, 
6 pt before 

 

Flush left. 
Hanging 
indent 
0.25” 

 

I. 
II.  
III. 
IV. 
 

Heading 3 
(Argument, 
subhead) 

12 Bold Single, 
6 pt before 

 

0.25” from 
left. 
Hanging 
0.25” 

 

A.  
B.  
C.  
D. 
 

Heading 4 
(Argument, 
sub-
subhead) 

12 Bold-
italic 

Single, 
6 pt before 

 

0.25” from 
left. 
Hanging 
0.25” 

 

1. 
2. 
3. 
4. 
 

Heading 5 
(Argument, 
sub-sub-
subhead) 

12 Italic Single, 
6 pt before 

 

0.25” from 
left. 
Hanging 
0.25” 

 

(a) 
(b) 
(c) 
(d) 
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Sample modify Heading 2, “Format” → “Font” settings 
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Sample modify Heading 2, “Format” → “Paragraph” settings 
 

   
 
Sample modify Heading 2, “Format” → “Numbering” setting 
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With your heading styles in place, as you write your brief, you can then 
either (a) select the heading with your cursor and then type, or (b) type 
your heading, highlight it, go up to the top ribbon, and select the heading 
number it is to be formatted and associated with. 

 

[Word side trip: Word’s “Navigation Pane,” when set to display, 
automatically shows a clickable, multi-level table of contents when your 
Word document is viewed. This feature is of considerable separate value 
for people who read your long, multi-argument memos and reports on a 
screen in Word. 

 

Consider helping your Word document reader(s) and use 
“Headings” as a part of your document-creation process when you author 
and intend to share long memos or reports. This makes it far more 
efficient for your reader(s) to navigate among the different sections of 
your document, especially when time is of the essence.] 
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You’re nearing the homestretch for the bookmarked brief 
formatting process. When you are ready to save your Word document as a 
.pdf file, select the “File” menu, and select “Save as Adobe PDF.” When this 
window appears: 
 

 
 
select the “Options” button. 
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At the next window, make sure that boxes “Create Bookmarks” and 
“Convert Word Headings to Bookmarks” are both checked. Select “OK.” 
 

 
  

Now give your Word document a file name and save it as a .pdf. 
(Tip: Choose a name that accurately reflects how you’d like it also to 
appear at the top of your Adobe bookmark tree if you intend to combine 
the primary document with exhibits (such as “Defendant Smith MSD,” 
“Appellant Supplemental Briefing,” and so forth)). 
 

 When that .pdf opens and you view the bookmarks, the bookmarks 
you earlier created in Word should appear on the left side of your Adobe 
Reader. (Spoiler alert: Section I(J) explains how to set the file properties so 
the Bookmarks’ panel automatically displays when the .pdf file is opened.) 
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2. Bookmarked attachments 
 
The second context where bookmarks should appear is to denote 

separate exhibit-like attachments. 
 

Section II walks you through the steps of organizing the 
attachments, selecting file names that simultaneously serve as bookmark 
names, and using Adobe Acrobat to combine the files. 

 

 Following these steps will avoid risking a Bookmarks panel which 
(unhelpfully) appears as:  
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F. External hyperlinks, considerations 
 

Before deciding whether to include hyperlinks to outside webpages, 
consult the court rules, administrative orders, and efiling standards to see 
if external hyperlinks are allowed. Be mindful that material associated with 
an external hyperlink, simply by the link’s insertion and absent a court 
order, is not part of the court record. 

 

As a practical matter, there is a persuasive school of thought that 
your efiling should be platform-independent. This approach discourages 
using external hyperlinks because there is no way you can be sure that 
your eventual reading audience(s) will be able to access the external 
hyperlinks while reading your filing. 

 

If court rules, administrative orders, or standards do not prohibit 
the use of external links and if you are still thinking about including 
hyperlinks to external sites, pause and consider who may be reading your 
filings and what is the most reliable way to make the information 
accessible. The answers may be fluid. Some considerations: 

 

 Offline readers. If you insert the hyperlink through Word 
(http://bit.ly/2J2o67Y) and only highlight and associate the 
link to the applicable term, is there a chance that the person 
reading your brief will not be online and thus cannot click 
through to the linked site? If so, rather than hyperlink to an 
external site, consider saving the external page as a .pdf file 
(from your web browser, select “Print,” and for the printer, 
select “Save as PDF”), and attach that .pdf file as an exhibit. 
(The attachment then becomes part of the court record.) 
 

 

http://bit.ly/2J2o67Y
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 Avoid link rot. The desire to avoid “link rot” is a different 
reason to not hyperlink to an outside webpage. “Link rot” 
refers to when the URL you listed in your document no 
longer serves up any content.10 This happens when web 
pages (or entire web sites) are moved or deleted. In other 
words, perhaps the web address you pasted into your brief 
will no longer work by the time a future reader tries to 
access it. 
 

 
 

The link rot risk is eliminated, however, if you instead opt to 
save the page as a .pdf file and include it in your court filing 
as an attachment. 
 
Link rot is alternatively avoided if you create a Perma Link 
(perma.cc). A Perma Link hyperlink “is a reliable, unbreakable 
link to an unalterable record of any page you’ve cited.” 

 

  

https://perma.cc/
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 Shorten any link names. If you opt to paste the written page 
address into the text of your brief, with the idea that the 
reader could later type the address into their web browser 
and pull up the page, be sensitive to long addresses. For 
example, the current web address of the Michigan Supreme 
Court’s Internal Operating Procedures is 
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/
ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf No one 
wants to type that long address into their internet browser if 
they are separately reading from a printed document. You 
can make the task less onerous by going to the free website 
https://bit.ly and shortening the link. In this example, Bit.ly 
shortens the link to http://bit.ly/2KBk0cz − something far 
more manageable. 

 
Original: 

http://courts.mi.gov/Courts/MichiganSupreme
Court/Clerks/ClerksOfficeDocuments/MCR%20
7.300%20IOPs.pdf 

Shortened: 
http://bit.ly/2KBk0cz 

 
 Navigate your reader to the point-specific page of a multiple-

page .pdf file that’s hosted on an external website. Despite 
the earlier qualifiers, if you still choose to hyperlink to an 
externally-hosted, multiple-page .pdf file and if your 
reference point is buried within that file, modify your 
hyperlink address so that the person is directly taken to the 
page you want them to see. For example, if you want to 
reference something that appears on page 30 of the 
Michigan Supreme Court’s Internal Operating Procedures, 
modify the hyperlink to point directly to page 30 by adding 
the highlighted: 
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/
ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf#page=3
0. Use Bit.ly to shorten the modified address and it becomes 
http://bit.ly/2IWydLo.  
 

http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf
https://bit.ly/
http://bit.ly/2KBk0cz
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf
http://bit.ly/2KBk0cz
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf#page=30
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf#page=30
http://courts.mi.gov/Courts/MichiganSupremeCourt/Clerks/ClerksOfficeDocuments/MCR%207.300%20IOPs.pdf#page=30
http://bit.ly/2IWydLo
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A reader who clicks on that link, or types it into a browser, is 
directly taken to page 30: 
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G. Electronic signatures 
 

Most electronic filings require no “wet” or hand signature. The 
signature requirement for an efiled document (including unnotarized 
affidavits) is typically satisfied by an electronic typed signature of “/s/ 
[Name]” or an image of a handwritten signature. 

 
1. /s/ Name 

 

The “/s/ [Name]” electronic signature block is easily formatted in 
Word. Example: 
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2. Graphic signature 
 

It is alternatively acceptable to pen one’s signature on a white piece 
of paper, scan it as an image, crop the image, and then “Insert” the 
signature image (as a “Picture”) into the Microsoft Word document. (Many 
do not care for this approach because the image still has a white 
background and it does not look ideal when inserted.) 

 

Those who want to create a digital signature with a transparent 
background may be interested in the video tutorial posted at 
http://bit.ly/2lX8CZu 

 

If either avenue seems to be overwhelming, it’s worth remembering 
that, in most jurisdictions, it’s acceptable simply to type “/s/ [Name]” in the 
primary Word document. 
 

3. Do not scan a physically signed document simply for the 
“signed” version  
  

There are so many reasons you should never print the entire Word 
document, sign the document (a “wet” signature), and then scan the entire 
document for efiling: 

 

 The document takes on a visually inferior quality when 
scanned (especially if the document was originally printed in 
some type of “Draft” or black and white format to use less 
ink/toner). 

 

 
 

 Tagged bookmarks and inserted links (internal and external) 
are eliminated in the printing and scanning process and no 
longer work. 

 

 The digital file size will balloon and unnecessarily eat up 
everyone’s disk storage space. (That would be the equivalent 

http://bit.ly/2lX8CZu
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of printing all the pages using 90# paper and then filing that 
cement block with the court!) 

 

 The scanned document is now an image and will have to be 
text-recognized. 

 

Bottom line: the collective negatives never justify hand-signing and 
scanning the entire document for efiling. (So please do not do it, unless it 
involves a notarized affidavit and you’re in a jurisdiction that does not 
participate in e-notarization.) 

 
H. “Inspect Document” and remove metadata 

 

Clients, colleagues, and staff may have each participated in drafting 
and editing. Their digital fingerprints are often stored in the file’s 
metadata. Make it a habit to remove that metadata before converting the 
Word file to .pdf (or sharing the “draft” file with others).11 

 

Microsoft’s “Inspect Document” tool resides within the “File” tab. 
Select the “Check for Issues” icon. 
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Select “Inspect Document” from the drop-down menu. 
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De-select “Headers, Footers, and Watermarks” (scroll down, if 
necessary) and then select “Inspect.” 
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“Remove All” of the “Document Properties and Personal 
Information.”  

 

Also remove any “Comments, Revisions, Versions, and Associations” 
if they are detected.  

 

Select “Close.” 
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I. Ensure all track changes and comments have been 
removed. 

 

All track changes and comments should have been removed in the 
earlier step. Double-check your work by viewing your Word document and 
ensure that nothing has slipped through. Avoid efiling a document which 
displays unaddressed track changes such as 
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J. Converting or saving as .pdf (do not print and scan; file 
size matters) 

 
Continuing with an earlier theme, native files should be 

electronically converted to (“Save As”) .pdf and not physically scanned. 
 

Testing it yourself is the most persuasive way to appreciate the 
difference. (Seeing is believing!) 

 

 Select any Word-created motion, brief, or report you want. 
While in Word, select the “File” tab and then “Save as Adobe 
PDF.” 
 

 For the comparison, send that same Word document to your 
printer. Now get up, retrieve the printed pages, go to your 
scanner, scan all those pages to .pdf format, name the file, 
text-recognize the file, and save it to your drive. 

 

 Now compare both digital files. 
 

o Which file has crisper font? Which has fuzzier text? 
 

o How do the digital file sizes compare?  
 

If you can’t make the time to do your own comparison, 
consider this example. 

 

A litigant posted on its public website the “Save as Adobe 
PDF” version of its court filing (using a “/s/ [Name]” 
signature block). But the litigant’s efiled version with the 
Michigan Supreme Court was hand-signed and scanned. 
From the below file size numbers, guess which file was 
converted from its native format and which one was 
scanned? 
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 Most courts cap the allowed data file size for efiled submissions. 
That cap frustrates filers who opt to scan everything, instead of “Save As 
PDF” from the native digital format. If there is only one thing you 
remember from this resource, let it be this: Make it your default practice to 
“Save As PDF” from native digital formats whenever possible. You will 
almost always end up with a higher quality of filing that also is far smaller 
in data size. Win-win! 
  

Assuming that you have opted simply to save your primary Word 
document as Adobe PDF, be certain to modify the .pdf’s display properties 
to ensure that when a future user opens the file, any created bookmarks 
will automatically display. 
 

This is accomplished by opening the primary file in Adobe. Go to File → 
Properties [or simply select CTRL + D] and then go to the “Initial View” tab 
and configure the file to display, by default, the “Bookmarks Panel and 
Page.” While in this feature, it helps also to adjust the “Magnification” 
setting to “Fit Width.” 
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II. Attachments 
 

 Thoughtful planning should be devoted to deciding how the 
primary document’s attachments will be packaged. Do not be the litigant 
who electronically files 1,200 pages of exhibits without bookmarks or an 
index table. 
 

First, decide what will be attached; make an ordered list.  
 

• For efficiency’s sake, this is the ideal time to create a new Word 
document and start drafting your appendix or exhibit index 
table.  
 

• You cannot populate the page number cells, at this point. (You 
will do that in Section II(E).)  

 

• But with your index table already drafted, later you can copy 
each “Document description” cell and paste that text into the 
separate Adobe “Text” window when you create the watermark 
titles for each attachment as outlined in Section II(C)(4). 

 
 

Appendix [or Exhibit] Index 

Document description Pages 

Appendix A: Thomas Bailey affidavit  

Appendix B: 12/05/2015 hearing transcript  

[or]  

Exhibit 1: Donald Jackson deposition  

Exhibit 2: Baraga County resolution  
 
 
 
 

Next, here are suggestions to make the electronic attachment 
process easier, both for you and the ones who later read what’s efiled. 
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A. Windows folder view settings 
  

Begin by creating one separate Windows folder to save the 
collected individual exhibits. Configure your Windows folder at the “View 
tab” to view the files’ “Details.” 

 

Also select the “Item check boxes” feature in the “Show/hide” menu 
so you can later simultaneously select several files by marking the check 
box that will appear on the left side of each file in the Windows content 
pane. 
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B. Prepare the individual attachment files 
 

1. Download or convert all files to .pdf from their native 
application (including photographs!) 

 

Work with the digital files you have access to before you think 
about heading to the scanner. For example, pristine versions of Michigan’s 
appellate orders and opinions should be directly downloaded from the 
results derived from “Case Search” page searches from courts.mi.gov (or 
from your commercial legal research provider). Michigan statutes can be 
downloaded from https://www.legislature.mi.gov by selecting a statute’s 
“Printer Friendly” and “Pdf Version” hyperlinks. 

http://www.courts.mi.gov/
http://www.legislature.mi.gov/
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Do not print, scan, and efile this: When you can download from courts.mi.gov,  

save as .pdf, and attach this: 
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For files not already in .pdf, (for example Word, Excel, PowerPoint, 
Outlook emails, or photographs) save each to .pdf. 

 

It’s worth repeating: Do not print to a black-and-white printer, scan, 
and convert to .pdf a subpar and fat file such as the version on the left … 

 

             1,064 KB                                                    107 KB 
                (bad)                                                     (fantastic!) 

 
 
… when you can print from your internet browser to .pdf and attach a 
color, perfectly text-recognized, and skinny file which looks like the one on 
the right. This admonition applies to trial court registers of action when 
they are available online. 
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Tip for attaching photographs: There is never a need to print a 
digital color photograph as a black-and-white document, scan it, and 
convert it to .pdf. Those are too many steps and it makes an unhelpful 
efiling. 

 

Contrast the quality and data size differences among four 
approaches: 

 
 

 
Color image printed as black and 
white, scanned, and saved as .pdf 

(4,301 KB) 
 

 
 

 
Color image printed as color, 
scanned, and saved as .pdf 

(3,883 KB) 
 

 

 
Color image inserted into a Word 
document as an image and saved 

as .pdf (1,518 KB) 
 

 
 

 
Color image printed to .PDF printer 

(340 KB)—Winner!! 
 
 

 

 



ePleasing eBriefing 
 

45 
 

 
Tip for saving Outlook emails as .pdf: If your Adobe-saved version 

of an Outlook email displays (annoyingly) a “Portfolio” header, such as this 
 

 
 
adjust your Outlook settings. From the Outlook ribbon, select the “ADOBE 
PDF” tab. 
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Then select “Change Conversion Settings Preferences.” 
 

 
 
Uncheck the box “Output Adobe PDF Portfolio when creating a new PDF 
file.” And select “OK.” 
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2. Re-size oversized attachments to 8-1/2 x 11 

 

What if an attachment was originally formatted to print on 11 x 17-
inch paper (for example, a spreadsheet)? In this example of the print 
preview, the existing print area is problematically too large for an 8-1/2 x 
11-inch page. 
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You can re-size that by adjusting the print settings to print to the 
“Adobe PDF” printer and “Fit.” Then “Print” the file and save your new 8-1/2 
x 11-inch formatted .pdf file. 
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Here is an example of a scanned newspaper article with an original 
size of 8-1/2 x 14-inches. It needs to be resized to fit on an 8-1/2 x 11-inch 
page. 
 

 
 
Even when using Adobe’s “Crop” tool, this article will still be 8-1/2 x 12-
inches at its original size. That is too big. 
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To resize the article, first “Crop” out the extra material (found within the 
“Edit PDF tool): 
 

 
 
Use the mouse to click, drag, and highlight the area to keep: 
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Select “OK” to confirm the area to be cropped. You can see that the article 
size will still be larger than what can fit onto an 8-1/2 x 11-inch sheet of 
paper. But that’s okay for now. 
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Select “Print” and at the Printer window select “Adobe PDF” as your 
printer, select “Fit” for the page sizing and notice how Adobe scales the 
article now to fit on an 8-1/2 x 11-inch sheet of paper. Select “Print” to 
save the file as a new .pdf 
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3. Redact personal and confidential information 
 

Court filings are public records, in general. To protect individual 
privacy and minimize identity theft risk, filers are encouraged to redact 
confidential personal information before filing their documents. Here are 
suggestions on how to redact the information when you must refer to it in 
your primary filing: 

 

 Taxpayer ID numbers, social security numbers, employer ID 
numbers, driver license, and passport numbers are redacted 
by leaving out everything but the last four numbers. For 
example: xxx-xx-1234. 
 

 Dates of birth are redacted by leaving out everything but the 
year. For example: xx/xx/1996. 

 

 Children’s names are redacted by leaving out everything but 
the child’s initials. For example: Roberto Mason might be 
redacted as R.M. or R------ M----. 

 

 Financial account numbers are redacted by leaving out 
everything but the last four numbers. Financial accounts 
include credit or debit card numbers, or bank, investment, 
and insurance account numbers. For example, you might 
redact a credit card number as: xxxx-xxxx-xxxx-1234. 

 

For digital attachments, Adobe Acrobat Pro DC’s Redact tool can 
remove content. https://adobe.ly/2NpSXhU 

 

Do not redact by using Adobe Acrobat’s “Draw” shapes tool to add 
colored shapes to text and block out personal information. While it will 
appear that the information has been blocked out, readers can still mouse 
over, select, copy, and paste the “covered” but still underlying text into a 
new Word document. 
 

For paper documents that need to be scanned to .pdf, physically 
block (or cut) out the personal information before scanning, and verify that 
the redacted information did not bleed through the scanned output. 
 
 
 
 
 
 

https://adobe.ly/2NpSXhU
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4. When physical scanning becomes necessary 
 

Some court rules require documents to be readable by sight. A 
filing (paper or electronic) which is unclear or able to be read may be 
rejected. Tips for successful scans: 
 

 Make sure that your scanner glass is clean and free of debris. 
Scanned files that have lines running across them or blotches 
are not helpful and will compromise the accuracy of later text 
recognition processes. 
 

 If using a document feeder, make sure that the guards are 
properly aligned and that the pages are not feeding in a 
crooked fashion. Slanted scans are not helpful. 

 

 If scanning bound books, make sure that the book edges are 
square with the scanner glass, and the scanner lid is lowered to 
minimize black page and spine edges. 

 

 Make sure that both sides are scanned if an original document is 
double-sided. 
 

 Separately scan each attachment. Do not batch scan all 
attachments into one file. 

 

 The scanned output should be set to .pdf (not .tiff, .png, or .jpeg 
images). 
 

 Normally scan in black and white, unless the item requires color. 
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 Scan using, at least, 300 dpi. The National Archives recommends 
(emphasis added): 12 

 
4.2 Scanned Text 
 

Scanned text is a photograph of a printed page produced 
either by a digital camera or scanner. 

General requirements for scanned text include: 

• Bitonal (1-bit black and white) images must be 
scanned at 300-600 ppi. Scanning at 600 ppi is 
recommended. This is appropriate for documents that 
consist exclusively of clean printed type possessing high 
inherent contrast (e.g., laser printed or typeset on a white 
background); 
  

• Gray scale (8-bit) must be scanned at 300-400 ppi. 
Scanning at 400 ppi is recommended. This is 
appropriate for textual documents of poor legibility 
because of low inherent contrast, staining or fading (e.g., 
carbon copies, thermofax, documents with handwritten 
annotations or other markings), or that contain halftone 
illustrations or photographs; and 
  

• Color (24-bit RGB [Red, Green, Blue]) must be 
scanned at 300-400 ppi. Scanning at 400 ppi is 
recommended. Color mode (if technically available) is 
appropriate for text containing color information 
important to interpretation or content. 
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5. Transcripts 
 

Use digital. Contact the court reporter and request a digital copy 
of the transcript(s) you intend to attach. Digital transcripts have the best 
appearance, and they require minimal disk space.  

 

One-sheet-per-page formatting. Only one-sheet-per-page 
transcripts may be filed in Michigan state courts as of September 1, 
2018.13 Compressed or “mini” versions of transcripts (ones where multiple 
transcript sheets appear on the same page) are too difficult to read or 
annotate on a screen. The scanned versions of mini-transcripts also often 
suffer from compromised text recognition.  

 

Transcript examples that should not be filed in Michigan courts 
(next page):
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Multiple sheets on one page are not allowed as of September 1, 2018. Electronic transcripts are 
preferred. If scanning is required, make certain that the pages do not feed into the scanner in a crooked 
fashion. Pages should be properly oriented when efiled.      
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C. Organize the files 
 

1. Rename each file 
  

Make sure that each needed file is now in .pdf. Rename each file so 
it begins with the object’s attachment designation as referenced in the 
primary filing. 

 

It is fine to include spaces in the file name. (You’ll later appreciate 
those spaces when it is time to combine the files and review the Bookmark 
names.) Avoid including symbols, as symbols will likely cause error. 

 

Example: 
 

 
If the attachments are instead 
referenced by letter, the file 
naming convention should 
begin: A, B, C, and so on. Either 
way, the files should flow in 
order when viewed in the 
Windows content pane. 
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2. Text-recognize all the files 
 

Text-recognize your files to ensure that they can be electronically 
searched (CTRL + F is the shortcut to search quickly for terms in a large 
document), annotated (highlight or comment), and are usable for copying 
and pasting tasks. “PDFs that are not text-[recognized] are viewed as 
technologically unsophisticated and will be met with frustration.”14  

 

A giant word of caution: A poor-quality scan will lead to less reliable 
text-recognition, poor highlighting, and inaccurate copy-and-paste 
functionality. This will greatly frustrate how future readers can(not) use 
your efiling. 
 

Consider this excerpt of a poorly scanned trial court decision efiled on 
appeal (the warning tip-off for appellate readers is the slanted scan): 
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What was efiled had not been text-recognized. Hypothetically 
assume that a judge or law clerk wanted to copy and paste a portion of 
that decision into a Word document (think ahead about the prospect of a 
future bench memo or draft opinion/order).  
 

First, she now has to stop and take time to text-recognize the file. 
 

Next would be to highlight and copy the section she wants to quote 
into a new document: 
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And now for the (not pretty) paste. Notice the haphazard font 
types, sizes, mis-capitalizations, and spacing problems: 

 

 
 
Poor quality scans = digital garbage. They are not functional and 

should be avoided at every possible turn. They work against you because 
they frustrate the very audience(s) you are trying to inform and persuade. 

 
Separate tip: Redact your files before you make them text-

searchable. 
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But once you have your high-quality scans in place and are ready to 
text-recognize them, fortunately, Adobe Acrobat allows you to do them all 
at once. 

 

Simply open one of your .pdf files. Select “Enhance Scans,” then 
“Recognize Text,” and then select “In Multiple Files...” At the “Add Files” 
drop-down menu, select “Add Folders.” Now select the folder where you 
earlier saved all of your attachments. Those files will load into the Adobe 
Acrobat menu. Select “OK.” 
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 At the next screen, verify that the output settings are targeted to 
overwrite your existing files. 
 

 
Select “OK.” 
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Additional settings will be verified in the “General Settings” screen.  
 
Reliable settings are: 
 
“Document Language” = 
English 
 
“Output” = Searchable Image 
 
“Downsample to” = 600 dpi 
 
Select “OK” when ready.  
 
Adobe will display this message if it encounters a page or file that has 
been text recognized. Simply mark the box “Ignore future errors in this 
document” and select “OK.” 
 

 
 

Adobe Acrobat will continue to text recognize all the files. Do not be 
alarmed, at the end of the process, if you encounter this message: 
 

 
Simply select “OK.” 
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3. Review and clean up each file 
 

After the files have been text-recognized, open each file and review 
the files as pages. Delete any blank pages and rotate the page orientation 
for any that still appear upside down or sideways. Save the changes. 

 

Why is this step important? Understandably, you do not want your 
“scrolling” readers to encounter files like these. (Tip: Improper-page 
orientation is a red flag that the filer either did not text-recognize his .pdf 
before filing, or the scanned quality of the document is so poor that 
Adobe could not text-recognize and re-orient the page.) 
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4. Add watermark titles to each file (not to be confused with 
headers or footers) 

 

It is easy for a reader to “get lost” in a sea of attachments and 
forget what a particular attachment’s page is about. You can easily assist 
the reader by going into each .pdf attachment and adding a watermark to 
the individual exhibit’s pages which (a) enumerates the exhibit, and (b) 
describes the document’s character. 
 

 With an individual attachment .pdf file open in Adobe Acrobat, 
select the “Edit PDF” tool, and choose “Add” a “Watermark” to the file. 
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In this example, the settings are configured for a “top” watermark. 
 

There’s great latitude in selecting the font type, size, color, and having it 
appear on each page of that file (vis-à-vis “Page Range Options”). 
 
Lawyer and typographer Matthew Butterick recommends using color for 
Bates numbering “because it’s meant to stand out on the page.”15 
 

 
 
 

Be strategic in the “Position” settings you select so that (a) your watermark 
will not interfere with the future court filing stamp, and (b) your watermark 
will print for anyone who prints your file (in other words, do not place it 
too close to the paper’s edge where a printer may cut it off).  
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Once you have settled on what the watermark’s settings will be, you 
can save those settings (and give it a name), so that you do not have to 
reconfigure them in each .pdf file. You’ll only have to modify the 
attachment’s naming convention (what appears in the “Text” box). 
 

 
 
 

This is the point when you go back to that Word index table you’ve 
been working on (as described at the beginning of Section II) and simply 
“copy” each document title from Word and “paste” it into the Adobe 
“Watermark” “Text” box for creating each watermark. 

  

Create, apply, and save a watermark title to each individual exhibit. 
 
Tip: Affixing watermarks on each exhibit eliminates any (past) need 

to create and insert separate divider pages (Exhibit 1, Exhibit 2, and so on.). 
 
 

5. Flatten each .pdf file (optional, but recommended) 
 

This is the juncture to flatten each .pdf attachment if you need to 
remove any active content such as JavaScript, macros, document security, 
editable text or images, draw fields, or comments. 
 

To do this, simply “File” → “Print” → “Print to PDF in Adobe 
Acrobat.” Of course, also “Save.” 

 

Reminder tip: Make sure that your “Adobe PDF” printer settings 
are not configured to “Save ink/toner.” When “Save ink/toner” is selected 
on the printer, even when you are just printing to Adobe PDF, the final 
output will be lighter in color (just as if you had printed to a physical 
printer). 

 
  



ePleasing eBriefing 
 

70 
 

6. Combine the attachment files into a single file 
 

Now you are ready to combine all the attachments into one file. 
Adobe makes it easy. 

 

From your Windows content pane (through File Explorer), simply 
select all the attachment files (this is where it’s convenient to select on the 
checkmark boxes), and right-click to “Combine Files in Acrobat.” 

 

 
 

The next window previews how the attachments will be combined. 
 

• Notice how they appear in order (such as 1, 2, 3, and 4)? 
 

• Also examine the “Bookmark for File” column. This previews 
how the Adobe Bookmark labels will appear after the files 
are combined. 

 

Because you exercised care in how you originally named these files, 
you should not have to adjust the Bookmark names. 
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If adjustments are needed, for example in the Bookmark name, 
simply right-click on the particular file, and select “Edit Bookmark for File.” 

 

 
 

When things appear in the order and fashion you desire, select 
“Combine Files” and Adobe will combine them into a “Binder.” 
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Once the .pdf Binder opens in Adobe, go into the “File” settings, and 
adjust the display properties under the “Initial View” tab so the binder is 
configured to display, by default, the “Bookmarks Panel and Page” and at 
the “Fit Width” Magnification. 
 

 

 
 
Save this Adobe binder, using whatever name you designate. 
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D. Bates page numbering appendices, if applicable 
 

Some jurisdictions (typically appellate) require appendix pages to 
be Bates stamped.  

 

Although Adobe Acrobat Pro is the only product − in the Adobe 
suite − which offers this tool by the “Bates” name (those how-to 
instructions are posted online at https://adobe.ly/2lUSacr), it is possible to 
format and insert “Bates-like” page numbers as a header or footer into 
your combined file. 

 

With the combined appendix open in Adobe Acrobat, select “Edit 
PDF.” 

 
 

 
 
 

And then “Add…” from the “Header & Footer” drop-down menu. 
 

 
 

https://adobe.ly/2lUSacr
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The below configuration reflects these settings: 
 

 
 
 Sego UI Bold font, 12-point, purple in color (color so that it 

stands out on the page). 
 

 “Insert Page Number” in the “Right Footer Text” area. 
 

 Locate the text to appear 0.5 inches from the “Bottom” and 
1.3 inches from the “Right.” (Notice the need to avoid the 
other images that appear on the lower right margin.) 

 

 Direct that the page number footers be applied to “All 
Pages” (from the “Page Range Options” hyperlink). 

 
 

Once you are satisfied with your configuration, select “OK.” 
 

“Save” the file to preserve the settings. 
 

  
 
 
 



ePleasing eBriefing 
 

75 
 

E. Create and insert an appendix index table at the 
beginning of the attachment file 

 

Having Bates-stamped (numbered) all the appendix pages, now go 
back to that Word index you’ve been working with and populate the page 
number cells. 

 
Appendix [or Exhibit] Index 

Document description Pages 

Appendix A: Thomas Bailey affidavit  

Appendix B: 12/05/2015 hearing transcript  

  

Exhibit 1: Donald Jackson deposition  

Exhibit 2: Baraga County resolution  
 

 
Save the Word index table and insert it into the beginning of your 

combined appendix .pdf file. Adobe’s how-to guide to add or insert a new 
page from an existing file is posted at https://adobe.ly/2KOIPxA. 
 

 
 

https://adobe.ly/2KOIPxA
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F. Adjust bookmarks’ display settings to “inherit zoom” 
 

As the file creator, you have no control over how your reader will 
view your digital file. You do not know what type of device she uses, the 
screen size, or her magnification preferences. 

 

You can be certain, however, that the reader will become annoyed if 
the display magnification changes each time she clicks on a different 
bookmark to view a different bookmarked attachment. She does not want 
to experience this, for example: 

 

viewing one attachment at 69.6% magnification (fit-width) 
 

 
but the display settings for the next bookmarked attachment load at 125%, 

forcing her to mouse over and adjust the viewing magnification  
(again, and again, and again)  
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As the file creator, you have a responsibility to your future digital-
reading audience to adjust each of your bookmark’s display settings to 
avoid this problem. 

 

You’ll recall that you already set the Document Properties to display 
at first at the “Fit Width” magnification. 
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Now, you need to go back to your Bookmarks panel, separately right-click 
on each bookmark, and select that bookmark’s “Properties.” 

 

 
 

Select the “Actions” tab and select “Edit.” 
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At the “Zoom” drop-down menu, select “Inherit Zoom,” and select “OK.” 
 

 
 
Do that for each bookmark in your exhibit/appendix file. This will 

ensure that your digital-reading audience will view each bookmarked 
attachment at the same display setting of whatever they were reading at in 
a different part of the file. Your reader will not have to repeatedly re-adjust 
the display settings to suit their preference. Adobe, instead, will 
automatically re-zoom the new page display to whatever their last viewing 
setting was. 
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G. Split large files, if necessary 
 

Courts vary in the file sizes allowed for uploading. You will have to 
split your large file into smaller bundles if it exceeds the cap. 

 

Files are split using Adobe’s “Organize Pages” tool. 
 

 
 
Select the “Split” icon. 
 

 
Next, define how you want the large file to be split. The below 

configuration instructs Adobe to “Split by” the “File Size.”  
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The originally created bookmarks are retained for each “Part.” And 

they will not be modified if the other e-served parties or a court user later 
opts to recombine the several parts into a single large file. [See Section 
II(C)(6) for directions on how to combine multiple files into one large file.] 
The originally created bookmarks will still work. 
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III. Bookmark formatting 
 

It is possible to modify, add, delete, nest, and format bookmarks 
after they have been created. 
 

Adobe’s how-to instructions to do that are posted at 
https://adobe.ly/2MTdiv3  

 

 
  

https://adobe.ly/2MTdiv3
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IV. Final checklist 
 
 

 
You are almost ready to efile! Before uploading your digital file(s), 
verify that 
 

 

 Fonts were embedded in the primary Word document. 

 Metadata was removed.  

 No tracked changes or comments appear in final document. 

 All personal or confidential information has been redacted. 

 Blank pages have been deleted. 

 All pages are properly oriented. 

 The files have been text-recognized. 

 The file properties are configured for the “Bookmarks Panel 
and Page” to display automatically. (Most readers assume 
that no bookmarks were created if they are not configured to 
display automatically.) 

 Each bookmark works and takes you to the designated page. 

 Each bookmarked attachment has “inherit zoom” display 
settings. 

 The external hyperlinks (if there are any) work. Test each one! 

 The file size is within the court system limitations, or split 
into parts that each fall within the filing cap. 

 The file looks good when you print it on paper (and any 
watermarks, headers, or footers are not cut off by the 
printer). 

 No files are locked or password-protected. 
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Endnotes 

1  http://bit.ly/2O8w6rO 
 

 
 
2  Fun fact: Carbon pages are still allowed to be filed in the Michigan 
Supreme Court, so long as the printing is legible. MCR 7.312(A) 
 
3  See generally Kerr, A Theory of Law, 16 GREEN BAG 2D 111 (2012). 
 
4  Garner, The Winning Brief (3rd Ed) (New York: Oxford University 
Press, 2014) p xiii. 
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5  Butterick, Typography for Lawyers (2nd Ed) (Houston: O’Connor’s, 
2015), p 24. 
 
6  ABA Council of Appellate Lawyers, The Leap from E-Filing to E-
Briefing: Recommendations and Options for Appellate Courts to Improve the 
Functionality and Readability of E-Briefs, pp 22-23 (2017). 
 
7  Garner, Id.at 440 recommends 14-point font (12 in footnotes). 
 
8  Garner, Id., Chapter 63 at pp 403-422 is an excellent resource (with 
examples) for structuring headings and nested sub-headings. The benefit 
of putting “a little more white space above a heading than below” is 
explained in Chapter 65. 
 
9  There are notable differences of opinion concerning argument 
capitalization: 
 

• The arguments, each portion of which must be prefaced by the 
principal point stated in capital letters or boldface type… MCR 
7.212(C)(7) (emphasis added) 

 

• “Avoid all-caps and initial-caps text. But if you ever do use initial 
caps (never in point headings), don’t capitalize an article, 
preposition, or conduction of four or fewer letters.” Garner, Id., 
Chapter 66 at pp 430-437. 

 
10  Zittrain, Albert, and Lessig, Perma: Scoping and Addressing the 
Problem of Link and Reference Rot in Legal Citations (October 1, 2013). 
Harvard Public Law Working Paper No. 13-42. Available at 
SSRN: https://ssrn.com/abstract=2329161 or http://dx.doi.org/10.2139/ssr
n.2329161 
 
11  The American Bar Association devotes a section of its website to 
metadata practices. http://bit.ly/2CrG2Z2  
 
12  http://bit.ly/2tWZ2KG  
 
13  MCR 1.109(D)(1)(a) 
 

https://ssrn.com/abstract=2329161
http://dx.doi.org/10.2139/ssrn.2329161
http://dx.doi.org/10.2139/ssrn.2329161
http://bit.ly/2CrG2Z2
http://bit.ly/2tWZ2KG


ePleasing eBriefing 
 

86 
 

 
14  Neiberger, Judge-Friendly Briefs in the Electronic Age.  89 Fla Bar J 2 
(February 2015). 
 
15  Butterick, Typography for Lawyers (2nd Ed) (Houston: O’Connor’s, 
2015), p 96. 
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